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Getting to Know Microsoft Office Versions
Using SAM Projects and Textbook Projects

Excel 201

MODULE ONE
Creating a Worksheet and a Chart
Objectives
Introduction
Project: Real Estate Budget Worksheet and Chart
Starting and Using Excel
What Is Excel?
To Start Excel and Create a Blank Workbook
The Excel Window
To Display a Different Tab on the Ribbon
Selecting a Cell
Entering Text
To Enter the Worksheet Titles
AutoCorrect
To Enter Column Titles
To Enter Row Titles
Entering Numbers
To Enter Numbers
Calculating Sums and Using Formulas
To sum a Column of Numbers
Using the Fill Handle to Copy
a Cell to Adjacent Cells
To Copy a Cell to Adjacent Cells in a Row
To Calculate Multiple Totals at the Same Time
Caleulating Average, Maximum, and Minimum
Values
To Enter a Formula Using the Keyboard
To Copy a Cell to Adjacent Cells in a
Row Using the Fill Handle
Saving the Project
To Save a Workbook
Formatting the Worksheet
Font Style, Size, and Color
To Change a Cell Style
To Change the Font
Ta Apply Bold Style to a Cell
To Increase the Font Size of a Cell Entry
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OFF-1
SAM-1

EX 1-1
EX 1-1
EX 1-1
EX 1-4
EX 1-4
EX 15
EX 1-7

EX 1-12

EX 112

EX 1-12

EX 1-13

EX 1-15

EX 1-15

EX 117

EX 1-18

EX 1-18

EX1-20

EX 1-20

EX 1-21
EX 1-22
EX 1-24

EX 1-25
EX1-26

EX 1-27
EX 1-27
EX 1-28
EX 1-30
EX 1-32
EX1-32
EX 1-34
EX 1-35
EX 1-36

Microsoft Office 365 &

EXCEL 2019

COMPREHENSIVE

To Change the Font Color of a Cell Entry
To Center Cell Entries across Columns
by Merging Cells
To Format Rows Using Cell Styles
To Format Numbers in the Worksheet
To Adjust the Column Width
To Use the Name Box to Select a Cell
Other Ways to Select Cells
Adding a Pie Chart to the Worksheet
To Add a Pie Chart
To Apply a Style to a Chart
Changing the Sheet Tab Names and Colors
To Move a Chart to a New Sheet
To Change the Sheet Tab Name and Color
Document Properties
Printing a Worksheet
To Preview and Print a Worksheet
in Landscape Orientation
Viewing ic Caleulati
To Use the AutoCalculate Area to
Determine a Maximum
Correcting Errors

Correcting Errors while Entering Data into a Cell

Correcting Errors after Entering Data into a Cell
Undoing the Last Cell Entry
Clearing a Cell or Range of Cells
Clearing the Entire Worksheet
Using Excel Help
To Obtain Help Using the Search Text Box
Obtaining Help while Working in an Office App
To Obtain Help Using the Tell Me Box
To Save a Workbook with a Different File Name
Tao Sign Out of a Microsoft Account

Summary

Apply Your Knowledge

Extend Your Knowledge

Expand Your World

In the Lab

EX 1-37

EX 1-38
EX1-39
EX 14
EX 1-42
EX 1-44
EX 1-44
EX 1-45
EX 1-46
EX 1-48
EX 1-29
EX 1-49
EX 1-50
EX 1-51
EX 1-52

EX 1-53
EX 1-56

EX 1-56
EX 1-57
EX 1-57
EX1-57
EX 1-59
EX 1-59
EX 1-60
EX 1-60
EX 1-81
EX1-63
EX 1-63
EX 1-64
EX 1-64
EX 1-65
EX 1-66
EX 1-68
EX 1-69
EX 1-69
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MODULE TWO

Formulas, Functions, and Formatting
Objectives

Introduction

Project: Worksheet with Formulas and Functions

Entering the Titles and Numbers into the Workshest

To Enter the Worksheet Title and Subtitle

To Enter the Column Titles

To Enter the Salary Data
Flash Fill

To Use Flash Fill

To Enter the Row Titles

To Change the Sheet Tab Name and Color
Entering Formulas

To Enter a Formula Using the Keyboard

Arithmetlc Operations

Order of Operations

To Enter Formulas Using Point Mode

To Copy Farmulas Using the Fill Handle
Option Buttons

To Determine Totals Using the AutoSum Button

To Determine the Total Tax Percentage
Using the AVERAGE, MAX, MIN, and other
Statistical Functions
To Determine the Highest Number in a
Range of Numbers Using the Insert
Function Dialog Box
To Determine the Lowest Number ina
Range of Numbers Using the Sum Manu
To Determine the Average of a Range
of Numbers Using the Keyboard
To Copy a Range of Cells across
Columns to an Adjacent Range Using
the Fill Handle
Verifying Formulas Using Range Finder
To Verify a Formula Using Range Finder
Formatting the Worksheet
To Change the Workbock Theme
To Format the Worksheet Titles
To Change the Background Color and Apply a
Box Border to the Worksheet Title
and Subtitle
To Apply a Cell Style to the Column
Headings and Format the Total Rows
To Format Dates and Center Data in Cells
To Apply an Accounting Number Format and
Comma Style Format Using the Ribbon
To Apply a Currency Style Format with a
Floating Dollar Sign Using the
Format Cells Dialog Box
To Apply a Percent Style Format and
Use the Increase Decimal Button
Conditional Formatting
To Apply Conditional Formatting
Conditional Formatting Operators
Changing Column Width and Row Height
To Change Column Width
To Change Row Height
Checking Spelling
To Check Spelling on the Worksheet
Additional Spelling Checker Considerations
Printing the Worksheet
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EX 21
EX 2-1
EX 2-2
EX2-4
EX2-4
EX2-5
EX 25
EX 2-6
EX 2-7
EX2-8
EX 28
EX2-9
EX 2.9
EX 2-10
EX 2-10
EX2-11
EX 213
EX 2-14
EX 2-14
EX 2-15

EX 2-16

EX2-16

EX2-18

EX 2-20

EX 2-21
EX 2-22
EX2-22
EX 2-23
EX2-24
EX 2-25

EX 2-26

EX 2-27
EX 2-28

EX 2-29

EX 2-30

EX 2-31
EX 2-31
EX2-32
EX 2-34
EX 2-35
EX 2-35
EX 2-38
EX 2-39
EX 2-40
EX2-41
EX 241

To Change the Worksheet's Margins, Header,
and Orientation in Page Layout View
To Print a Worksheet
To Print a Section of the Worksheet
Displaying and Printing the Formulas Version
of the Worksheet
To Display the Farmulas in the Worksheet
and Fit the Printout on One Page
To Change the Print Scaling Option
Back to 100%
Summary
Apply Your Knowledge
Extend Your Knowledge
Expand Your World
in the Lab

MODULE THREE

Working with Large Worksheets,

Charting, and What-If Analysis

Objectives

Introduction

Project: Financial Projection Worksheet with
What-If Analysis and Chart

To Enter the Worksheet Titles and Apply a Theme

Rotating Text and Using the Fill Handle
to Create a Series
To Rotate Text ina Cell
To Use the Fill Handle to Create a Series
of Month Names
Using the Aute Fill Options Menu
To Increase Column Widths
To Enter and Indent Row Titles
Copying a Range of Cells to a Nonadjacent
Destination Area
To Copy a Range of Cellsto a
Nonadjacent Destination Area
Using the Paste Options Menu
Using Drag and Drop to Move or Copy Cells
Using Cut and Paste to Move Cells
Inserting and Deleting Cells in a Worksheet
To.Insert a Row
Inserting Columns
Inserting Single Cells or a Range of Cells
Deleting Columns and Rows
To Enter Numbers with Format Symbols
To Enter the Projected Monthly Sales
To Enter and Format the System Date
Absolute versus Relative Addressing
To Enter a Formula Containing Absclute
Cell References
Making Decisions—The IF Function
To Enter an IF Function
To Enter the Remaining Formulas for January
To Copy Formulas with Absolute Cell
References Using the Fill Handle
To Determine Row Totals in Nonadjacent Cells
Nested Forms of the [F Function
Adding and Formatting Sparkline Charts
To.Add a Sparkline Chart to the Worksheet
To Change the Sparkline Style and Copy
the Sparkline Chart
To Change the Sparkline Type
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EX 242
EX 2-44
EX 2-45

EX 2-46

EX 2-47

EX 2-48
EX 2-49
EX 2-50
EX 2-51
EX 2-52
EX 2-53

EX 31
EX 31

EX 3-2
EX 35

EX 35
EX 3-5

EX 37
EX 3-8
EX 39
EX 3-10

EX 3-10

EX 3-11
EX 312
EX 3-12
EX 313
EX 3-13
EX 314
EX 3-15
EX 3-15
EX 3-16
EX 3-16
EX 317
EX 3-18
EX 3-20

EX 3-22
EX 3-24
EX 3-25
EX 3-26

EX 3-27
EX 3-28
EX 3-29
EX 3-30
EX 3-30

EX 3-31
EX 3-32



vi Contents

Customizing Sparkline Charts
Formatting the Worksheet
To Assign Formats to Nonadjacent Ranges
To Format the Worksheet Titles
To Assign Cell Styles to Nonadjacent
Rows and Colors to a Cell
To Copy a Cell's Format Using the
Format Painter Button
To Format the What-if Assumptions Table
Adding a Clustered Column Chart to the Workbook
To Draw a Clustered Column Chartona
Separate Chart Sheet Using the
Recommended Charts Feature
To Insert a Chart Title
To Add Data Labels
To Apply Chart Filters
To Add an Axis Title to the Chart
To Change the Chart Style
To Modify the Chart Axis Mumber Format
To Remove Filters and Data Labels
Organizing the Workbook
Ta Rename and Color Sheet Tabs
To Reorder the Sheet Tabs
To Check Spelling in Multiple Sheets
To Preview and Print the Worksheet
Changing the View of the Worksheet
To Shrink and Magnify the View
of a Worksheet or Chart
To Split a Window inta Panes
To Remove the Panes from the Window
To Freeze Worksheet Columns and Rows
To Unfreeze the Worksheet Columns and Rows
What-If Analysis
To Analyze Data In a Worksheet by
Changing Values
Goal Seeking
To Goal Seek
Insights
To Use the Smart Lookup Insight
Accessibility Features
Summary
Apply Your Knowledge
Extend Your Knowledge
Expand Your World
In the Lab

MODULE FOUR
Financial Functions, Data Tables, and
Amortization Schedules
Objectives
Introduction
Project: Mortgage Payment Calculator with Data
Table and Amortization Schedule
To Apply a Themne to the Worksheet
To Enter the Section and Row Titles and
System Date
To Adjust the Column Widths and Row Heights
To Change the Sheet Tab Name
Creating Cell Names
To Format Cells before Entering Values
To Enter the Loan Data
To Create Names Based on Row Titles

EX 3-33
EX 3-33
EX 3-34
EX 3-36

EX 3-37

EX 3-38
EX 3-39
EX 3-39

EX 3-40
EX 3-42
EX 3-42
EX 3-43
EX 3-44
EX 345
EX 3-46
EX 3-47
EX 3-48
EX 3-48
EX 3-48
EX 3-49
EX 3-49
EX 3-50

EX 3-50
EX 3-52
EX 3-53
EX 3-53
EX 3-55
EX 3-55

EX 3-55
EX 3-56
EX 3-56
EX 3-58
EX 3-58
EX 3-59
EX 3-60
EX 3-61
EX 3-62
EX 3-64
EX 3-65

EX 41
EX 4-1

EX 4-2
EX 44

EX 4-4
EX 4-5
EX 4-6
EX 4-6
EX 4-6
EX 4-7
EX 4-8

Shelly Cashman Series® Microsoft” Office 365" & Excel” 2019 Comprehensive

To Enter the Loan Amount Formula Using
Names
The PMT Function
To Enter the PMT Function
Other Financial Functions
To Determine the Total Interest and Total Cost
To Enter New Loan Data
To Enter the Original Loan Data
Using a Data Table to Analyze Worksheet Data
To Enter the Data Table Title and
Column Titles
To Create a Percentage Series Using
the Fill Handle
To Enter the Formulas in the Data Table
To Define a Range as a Data Table
More about Data Tables
Creating an Amortization Schedule
To Change Column Widths and Enter Titles
Tao Create a Series of Integers Using the
Fill Handle
Farmulas in the Amaortization Schedule
To Enter the Formulas in the Amortization
Schedule
To Copy the Formulas to Fill the Amortization
Schedule
To Enter the Total Formulas in the Amortization
Schedule
To Farmat the Numbers in the Amortization
Schedule
Formatting the Worksheet
To Add Custom Borders to a Range
To Add Borders to the Varying Interest Rate
Schedule
To Add Borders to the Amaortization Schedule
To Use Borders and Fill Color to Visually
Define and Group the Financial Tools
Highlighting Cells in the Data Table Using
Conditional Formatting
To Add a Pointer to the Data Table Using
Conditional Formatting
Ta Enter New Loan Data
To Enter the Original Loan Data
Printing Sections of the Worksheet
To Set Up a Worksheet to Print
To Set the Print Area
To Name and Print Sections of a Worksheet
Creating Formulas with Defined Names
Protecting and Hiding Worksheets and
Workbooks
To Protect a Worksheet
More about Worksheet Protection
To Hide and Unhide a Worksheet
To Hide and Unhide a Workbook
Formula Checking
To Enable Background Formula Checking
More about Background Formula
Checking
Summary
Apply Your Knowledge
Extend Your Knowledge
Expand Your World
In the Lab

EX 4-9
EX 4-10
EX4-11
EX 412
EX 413
EX4-13
EX 4-14
EX 4-15

EX 4-16

EX 416
EX4-18
EX 4-19
EX 4-20
EX 4-20
EX4-21

EX 4-22
EX 4-23

EX 4-24

EX 4-26

EX 4-27

EX 4-28
EX 4-29
EX 4-29

EX a-31
EX 4-32

EX 4-33

EX 4-33

EX 4-34
EX 436
EX 4-36
EX 4-37
EX 4-37
EX 4-38
EX 4-38
EXa-11

EX 4-41
EX 4-42
EX 4-44
EX 4-44
EX 4-45
EX 4-46
EX 4-47

EX 448
EX 4-49
EX 4-50
EX 4-51
EX 4-53
EX 4-54

Caprright X0 Comgage Lemiing. Al Rights Mescrvsd, My pot be copinl. scansed. or dapbcatsd, mwhile ar fn . e 10 ehecrmic righte. s il frrty conmient may bo e fom the eBook sdi oCapie

Falitarin rrvien hus theersee e auy sspprvrsed comiens doe ot maierisily st the ireeral beaming expericre. Covginge Lexsing reserves the tigh i remme

i

i aary nme i ights ¢



Shelly Cashman Series® Microsoft? Office 365® & Excel® 2019 Comprehensive Contents vii

MODULE FIVE
Working with Multiple Worksheets
and Workbooks
Objectives
Introduction
Project: Consolidated Expenses Worksheet
Creating the Consolidated Worksheet
To Apply a Theme
To Format the Worksheet
To Enter the Title, Subtitle, and Row Titles
To Enter Column Titles
Fill Series
To Create Linear Series
Date, Time, and Round Functions
To Use the TODAY Function
To Enter Formulas Using the ROUND Function
To Format the Title and Subtitle
To Format the Column Titles and Total Row
To Format with a Floating Dollar Sign
Format Codes
To Create a Custom Format Code
To Farmat with the Comma Style
Creating a Cell Style
To Create a New Cell Style
To Apply a New Style
To Use the Spelling Checker
Working with Multiple Worksheets
To Add a Worksheet to a Workboak
Tao Copy and Paste from One Waorksheet to
Another
To Copy & Worksheet Using a Shortcut Menu
To Copy a Worksheet Using cTRL
To Drill an Entry through Worksheets
Selecting and Deselecting Sheets
Customizing the Individual Worksheets
To Medify the Lady Lobster Worksheet
To Modify the Henry Haddock Sheet
To Medify the Sharon Shrimp Worksheet
Referencdng Cells Across Worksheets
To Madify the Consolidated Worksheet
To Enter a 3-D Reference
To Use the Paste Gallery
Formatting Pie Charts
To Insert a 3-D Pie Chart on a Worksheet
To Move a Chart on the Same Worksheet
To Resize a Chart
To Explode a Slice
To Rotate the 3-D Pie Chart
To Format Data Labels
To Add a Chart Border
Printing Multiple Worksheets
To Change Margins and Center the Printout
Horizantally
To Add a Header
To Add a Footer
To Preview and Print All Worksheets
in a Workbook
Creating Separate Files from Worksheets
To Create a Separate File from a Worksheet
Consolidating Data by Linking Separate Workbooks
Maoving Linked Workbooks
To Open a Data File and Save Ittoa
New Location

EX 51
EX 5-1
EX 5-2
EX 5-4
EX 5-4
EX 5-5
EX 5-5
EX5-6
EX 5-6
EX 5-6
EX 5-8
EX 5-10
EX5-11
EX5-14
EX 5-15
EX 5-15
EX 5-16
EX 5-17
EX5-19
EX 5-19
EX 5-20
EX 5-22
EX 5-23
EX 5-23
EX 5-24

EX 5-24
EX 5-25
EX 5-26
EX 5-27
EX 5-28
EX 5-28
EX 5-28
EX 5-29
EX 5-30
EX 5-31
EX 5-32
EX 532
EX 5-34
EX 535
EX 5-36
EX 5-36
EX 537
EX 5-38
EX 5-39
EX 5-39
EX 5-42
EX 5-43

EX 5-43
EX 5-44
EX 545

EX 5-46
EX 5-48
EX 5-48
EX 549
EX 5-49

EX 5-50

To Search for and Open Workbooks EX 5-50
To Switch to a Different Open Workbook EX 5-51
To Arrange Multiple Workbooks EX 5-52
To Hide Workbooks EX 5-53
To Consolidate Data by Linking Workbooks EX 5-54
To Close All Workbooks at One Time EX 5-57
Summary EX 5-57
Apply Your Knowledge EX 5-58
Extend Your Knowledge EX 5-60
Expand Your World EX 5-61
In the Lab EX 5-62
MODULE SIX
Creating, Sorting, and Querying a Table
Objectives EX 6-1
Introduction EX 6-1
Project: Rating Bank Account Managers EX 6-2
To COpen and Save a File EX 6-6
Table Guidelines EX 6-7
Creating a Table EX 6-7
To Format a Range as a Table EX 6-8
To Wrap Text EX 6-9
To Name the Table EX6-10
To Remove Duplicates EX6-10
To Enter New Rows and Records into a Table EX B6-11
To Add New Columns to the Table EX6-12
To Center Across Selection EX6-13
Using a Lookup Table EX 6-14
To Create a Table Array Area EX6-15
To Use the VLOOKUP Function EX 616
Adding Calculated Fields to the Table EX 6-17
To Create Calculated Fields EX6-17
Conditional Formatting EX 6-19
To Add a Conditional Formatting Rule with
an lcon Set EX 6-20
Finding Duplicates with Conditional
Farmatting EX 6-22
Data Bars EX 6-22
Working with Tables in Excel EX6-22
To Insert a Total Row EX 6-22
To Print the Table EX 6-24
Sorting a Table EX 6-25
To Sort Ascending EX 6-26
To Sort Descending EX 6-27
To Custom Sort a Table EX 6-27
Querying a Table Using AutoFilter EX 6-30
To Sort a Table Using AutoFilter EX 6-30
To Query a Table Using AutoFilter EX 6-31
To Remove Filters EX 6-32
To Search a Table Using AutoFilter EX 6-33
To Enter Custom Criteria Using AutoFilter EX 6-34
More about AutoFilters EX 6-36
To Turn Off AutoFilter EX 6-36
Using Criteria and Extract Ranges EX 6-37
To Create a Criteria Range EX 6-37
Te Query Using a Criteria Range EX 6-38
To Create an Extract Range EX 6-39
To Extract Records EX 6-40
More about the Criteria Range EX 6-41
Using Database Functions EX 6-41
To Create an Qutput Area EX 6-42
To Use the DAVERAGE and DCOUNT
Database Functions EX 643
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Using the Sumif, Countif, Match, and Index Functions
To Use the SUMIF Function
To Use the COUNTIF Functions
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MODULE EIGHT
Working with Trendlines, PivotTables,
PivotCharts, and Slicers
Objectives
Introduction
Project: Bell & Rodgers Accounting

To Start Excel and Open a Workbook
Line Charts and Trendlines

To Create a 2-D Line Chart

To Format a 2-D Line Chart

To Add a Trendline to a Chart

To Change the Theme

More about Trendlines

To Change the Format of a Data Point
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Getting to Know
Microsoft Office Versions

Cengage is proud to bring you the next edition of Microsoft Office. This
edition was designed to provide a robust |learning experience that is not
dependent upon a specific version of Office,

Microsoft supports several versions of Office:

* Office 365: A cloud-based subscription service that delivers
Microsoft’'s most up-to-date, feature-rich, modern productivity tools
direct to vour device. There are variations of Office 365 for business,
educational, and personal use. Office 365 offers extra online storage
and cloud-connected features, as well as updates with the latest
features, fixes, and security updates.

e Office 2019: Microsoft’'s “on-premises” version of the Office apps,
available for both PCs and Macs, offered as a static, one-time
purchase and outside of the subscription model.

* Office Online: A free, simplified version of Office web applications
(Word, Excel, PowerPoint, and OneNote) that facilitates creating and
editing files collaboratively.

Office 365 (the subscription model) and Office 2019 (the one-time pur-
chase model) had only slight differences between them at the time this
content was developed. Over time, Office 365’s cloud interface will con-
tinuously update, offering new application features and functions, while
Office 2019 will remain static. Therefore, your onscreen experience may
differ from what you see in this product. For example, the more advanced
features and functionalities covered in this product may not be available
in Office Online or may have updated from what you see in Office 2019.

For more information on the differences between Office 365, Office 2019,
and Office Online, please visit the Microsoft Support site.

Cengage is committed to providing high-quality learning solutions for
you to gain the knowledge and skills that will empower you throughout
your educational and professional careers.

Thank you for using our product, and we look forward to exploring the

future of Microsoft Office with you!
Getting to Know Microsoft Office Versions
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Using SAM Projects
and Textbook Projects

SAM and MindTap are interactive online platforms designed to transform
students into Microsoft Office and Computer Concepts masters. Practice
with simulated SAM Trainings and MindTap activities and actively apply
the skills you learned live in Microsoft Word, Excel, PowerPoint, or Access.
Become a more productive student and use these skills throughout

your career.

If your instructor assigns SAM Projects:
1. Launch your SAM Project assignment from SAM or MindTap.

2. Click the links to download your Instructions file, Start file, and
Support files (when available).

3. Open the Instructions file and follow the step-by-step instructions.

4. When you complete the project, upload your file to SAM or MindTap
for immediate feedback.

To use SAM Textbook Projects:
1. Launch your SAM Project assignment from SAM or MindTap.

2. Click the links to download your Start file and Suppeort files
(when available).

3. Locate the module indicated in your book or eBook.

4. Read the module and complete the project.

mﬁ * Open the Start file you downloaded.

" Save, close, and upload your completed project to receive
m“ immediate feedback.

. o

IMPORTANT: To receive full credit for your Textbook Project, you must
complete the activity using the Start file you downloaded from SAM

or MindTap.
Using SAM Projects and Textbook Projects
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Creating a Worksheet
and a Chart

Objectives
After completing this module, you will be able to:
= Start an app * Format cells in a worksheet
« Identify the components of the = Create a pie chart
Micrasoit Office ribbon » Change a worksheet name and sheet
= Describe the Excel worksheet tab color
= Enter text and numbers » Change document properties
= Use the Sum button to sum a range * Preview and print a worksheet
of cells » Use the AutoCalculate area to display
= Enter a simple function statistics
= Copy the contents of a cell to a range « Correct errors on a worksheet
of cells using the fill handle « Use Microsoft Office Help

Apply cell styles

Introduction

Almost every organization collects vast amounts of data. Often, data is consolidated
into a summary so that people in the organization better understand the meaning of
the data. An Excel worksheet allows data to be summarized and charted easily. A chart
is a graphic element that illustrates data. In this module, you will create a worksheet
that includes a chart. The data in the worksheet and chart comprise a budget that
contains monthly estimates for each income and expense category.

Project: Real Estate Budget Worksheet and
Chart

The project in this module follows proper design guidelines and uses Excel to create
the worksheet and chart shown in Figure 1-1a and Figure 1-1b. The worksheet
contains budget data for Frangold Realty. Mrs. Frangold has compiled a list of her
projected expenses and sources of income and wants to use this information to
create an easy-to-read worksheet. In addition, she would like a pie chart to show her
estimated monthly expenses by category.
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Figure 1-1(a) Real Estate Budget Worksheet
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Figure 1-1(b) Pie Chart Showing Monthly Expenses by Category

EX1-2
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The first step in creating an effective worksheet is to make sure you understand
what is required. The person or persons requesting the worksheet may supply their
requirements in a requirements document, or you can create one. A requirements
document includes a needs statement, a source of data, a summary of calculations, and
any other special requirements for the worksheet, such as charting and web support.
Figure 1-2 shows the requirements document for the new workbook to be created in
this module.

Worksheet Title Frangold Real Estate Budget

Need A yearly projection of Frangold Realty's budget

Source of data Data supplied by Madelyn Frangold includes monthly estimates for income
and expenses

Calculations The following calculations must be made:

1. For each menth, a total for income and expenses
2. For each budget item, a total for the item

3. For the year, total all income and expenses

4. Net income = Total income - Expenses

Figure 1-2

Why is it important to plan a worksheet?

The key to developing a useful worksheet is careful planning. Careful planning can reduce your effort significantly and result in
a worksheet that is accurate, easy to read, flexible, and useful. When analyzing a problem and designing a worksheet solution,
what steps should you follow?

1. Define the problem, including need, source of data, calculations, charting, and web or special requirements.

2. Design the worksheet.

3. Enter the data and formulas.

4. Test the worksheet.

After carefully reviewing the requirements document (Figure 1-2) and making
the necessary decisions, the next step is to design a solution or draw a sketch of the
worksheet based on the requirements, including titles, column and row headings, the
location of data values, and the pie chart, as shown in Figure 1-3. The dollar signs and
commas that you see in the sketch of the worksheet indicate formatted numeric values.

EX1-3
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EX 1-4 Excel Module 1 Creating a Worksheet and a Chart

sketch of
worksheet

and chart

Real Estate Budget Worksheet
Income January December Total
Commission $99,999.09 $99,099.99 $99,999.99
Interest
Total $989,999.99 $99,999.99 $95,998.99
Expsnus January December Total
Rent $99,999.99 $99,999.99 $99,999.99
Utilities
Advertising
Website
Printing
Office Supplies
Gas
Miscellaneous
Total $99,992.99 $929,999.99 $99,992.89
Net $99,999.99 $99,999.99 $99,999.99
Monthly Expenses
Legend of Expenses
Figure 1-3

With a good understanding of the requirements document, an understanding of
the necessary decisions, and a sketch of the worksheet, the next step is to use Excel to
create the worksheet and chart.

Starting and Using Excel
What Is Excel?

Excel is a powerful spreadsheet app that allows users to organize data, complete
calculations, make decisions, graph data, develop professional-looking reports, publish
organized data to the web, and access real-time data from websites. The four major
parts of Excel are as follows:

* Workbooks and Worksheets: A workbook is like a notebook. Inside the
workbook are sheets, each of which is called a worksheet. A worksheet is a
single sheet in a workbook file that lets you enter and manipulate data, perform
calculations with data, and analyze data. Thus, a workbook is a collection of
worksheets. Worksheets allow users to enter, calculate, manipulate, and analyze
data, such as numbers and text. The terms “worksheet” and “spreadsheet” are
interchangeable.

® Charts: Excel can draw a variety of charts, such as column charts and pie charts.

* Tables: Tables organize and store data within worksheets. For example, once
a user enters data into a worksheet, an Excel table can sort the data, search for
specific data, and select data that satisfies defined criteria.
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Creating a Worksheet and a Chart Excel Module 1 EX 1-5

* Web Support: Web support allows users to save Excel worksheets or parts of a
worksheet in a format that a user can view in a browser, so that a user can view
and manipulate the worksheet using a browser. Excel web support also provides
access to real-time data, such as stock quotes, using web queries.

To Start Excel and Create a Blank Workbook

Across the bottom of the Windows desktop is the taskbar. The taskbar contains the Start button, a
clickable button at in the lower left corner of the Windows 10 screen that you click to open the Start menu.
The Start menu provides access to all programs, documents, and settings on the computer. The Start menu
may o ntain one of more fnltlr:rs. and these folders can be used to group related apps l‘ugtt}‘lcr. A folder is an
clectronic container that helps you organize your computer files, like a cardboard folder on your desk; it can
contain subfolders for organizing files into smaller groups.

The Start menu allows you to start programs, store and search for documents, customize the computer
or mobile device, and sign out of a user account or shut down the computer or mobile device. A menu is a list
of related items, including folders, programs, and commands. Each command on a menu performs a specific
action, such as saving a file or obtaining help. Why? Commands are one of the principal ways you communicate with
ait app so you can tell it what you want it to do.

The following steps, which assume Windows is running, use the Start menu to start Excel and create
a blank workbook based on a typical installation. You may need to ask your instructor how to start Excel on
your computer.

(1

« sam’' ¥ Click the
Start button on the
Windows taskbar seate
to display the Start
menu containing a 1 ‘/g [~
list of apps installed
on the computer or
mobile device.

Start menu

Catendar Mad

If necessary, scroll : . ’ f—
to display Excel
(Figure 1-4).

isrosaft e

Excel app name

Note: To help you locate screen
- elements that are referenced
L in the step instructions, such
Aty e as buttons and commands, this

Start button book uses red boxes to point
to these screen elements

Figure 1-4
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EX 1-6 Excel Module 1 Creating a Worksheet and a Chart

o | Microsoft Excel
is running

¢ Click Excel to start J
. Blank workbook
the app (Figure 1-5). Good evening thumbnail, or
/ miniature image
= ¥ ¢ ¥V € ¥V ¢ g =X
— sk Take a
Formulas PivotTable tour
P + & & ] L o ebor
[R——
ﬂ Pirned SRR Wit Me
Figure 1-5

3]

# Click the Blank

Excel Window

workbook
thumbnail on the
Excel start screen
to create a blank
Excel workbook in i
the Excel window 2
(Figure 1-6). 5
.
< |What happens when [
g I start Excel? :-:
Excel provides a 3
means for you u
to create a blank "
document, as shown :
in Figure 1-5. 5
After you click the 2 5 - -
Blank workbook N Wiz o a—
thumbnail, the Excel Figure 1-6
window shown in
Figure 1-6 opens. A window is a rectangular-shaped work area that displays an app or a collection of files, folders,

and Windows tools. A window has a title bar, an area at the top of a document window or app window that

displays the file name and program name

| Other Ways

‘ 1. Type app name in search box, click app name in results list
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Creating a Worksheet and a Chart Excel Module 1 EX 1-7

The Excel Window

The Excel window consists of a variety of components to make your work more efficient and worksheets
more professional, These include the worksheet window, ribbon, Tell Me box, Quick Access Toolbar, and
Microsoft Account area.

Excel opens a new workbook with one worksheet. If necessary, you can add additional worksheets. Each
worksheet has a sheet name that appears on a sheet tab, an indicator at the bottom of the window that identifics
a worksheet. For example, Sheetl is the name of the active worksheet displayed in the blank workbook shown in
Figure 1-7. You can add more sheets to the workhook by clicking the New shect button.

Excel Module 1

Worksheet The worksheet is organized into a rectangular grid containing vertical columns and horizontal
rows. A calumn letter in a box above the grid, also called the column heading, appears above each worksheet
column to identify it. A row number in a box on the left side of a worksheet row, also called the row heading,
identifies each row.

The intersection of each column and row is a cell. A cell is the box, formed by the intersection of a column
and a row, where you enter data. Each worksheet in a workbook has 16,384 columns and 1,048,576 rows for a
total of 17,179,869,184 cells. Only a small fraction of the active worksheet appears on the sereen at one time.,

A cell is referred to by its unique address, or cell reference, which is the column letter and row number
location that identifies a cell within a worksheet, such as Al.To identify a cell, specify the column letter first,
followed by the row number. For example, cell reference D5 refers to the cell located at the intersection of
column D and row 35 (Figure 1-7).

One cell on the worksheet, designated the active cell, is the worksheet cell into which you are entering
data. The active cell in Figure 1-7 is Al. The active cell is identified in three ways. First, a heavy border
surrounds the cell; second, the active cell reference shows immediately above column A in the Name box;
and third, the column heading A and row heading 1 are highlighted so that it 1s easy to see which cell is active
(Figure 1-7).
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Figure 1-7
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EX 1-8 Excel Module 1 Creating a Worksheet and a Chart

The evenly spaced horizontal and/or vertical lines used in a worksheet or chart are called gridlines.
Gridlines make a worksheet casier to read. If desired, you can turn the gridlines off so that they do not show on
the worksheet. While learning Excel, gridlines help you to understand the structure of the worksheet.

The pointer appears as a block plus sign whenever it is located in a cell on the worksheet. Another
common shape of the pointer is the block arrow. The pointer turns into the block arrow when you move it
outside the worksheet or when you drag cell contents between rows or columns.

Scroll Bars Scroll bars on the right edge (vertical seroll bar) and bottom edge (horizontal seroll bar) of a
document window let you view a document that is too large to fit on the sereen at once. You use a scroll bar to
display different portions of a document in the document window, On a scroll bar, the position of the scroll box
reflects the location of the portion of the document that is displayed in the document window.

Status Bar The status bar is the gray bar at the bottom of the Excel window that shows status information
about the currently open worksheet, as well as view buttons and zoom controls. As you type text or perform
certain tasks, various indicators and buttons may appear on the status bar. The right side of the status bar
includes buttons and controls you can use to change the view of a document and adjust the size of the displayed
document.

Ribbon The ribbon (shown in Figure 1-8) is a horizontal strip near the top of the window that contains tabs
(pages) of grouped command buttons that you click to interact with the app. Each tab in the ribbon contains a group
of related commands and settings. Each group is a tab element on the ribbon that contains related commands.
When you start an Office app, such as Excel, it initally displays several main tabs, also called default or top-level
tabs. All Office apps have a Home tab, which contains the more frequently used commands. When you start Excel,
the ribbon displays ten main tabs: File, Home, Insert, Draw, Page Layout, Formulas, Data, Review, View, and Help.
(1f you are using a desktop computer, you might not see the Draw tab.)
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Creating a Worksheet and a Chart Excel Module 1 EX 1-9

In addition to the main tabs, Excel displays tool tabs, also called contextual tabs (Figure 1-9), tabs that
appear in addition to the main tabs on the ribbon when you perform certain tasks or work with objects, such as
pictures or tables. If you insert a chart in an Excel workbook, for example, the Chart Tools tab and its related
subordinate Design and Format tabs appear, collectively referred to as the Chart Tools Design tab or the Chart
Tools Format tab. When you are finished working with the chart, the Chart Tools tabs disappear from the

ribbon. Excel determines when tool tabs should appear and disappear based on tasks you perform.

File Oraw

i E D

Add Chart Quick  Change
Element - Leyout- Colars -

Home Insert Page Layout

o - =
=

Chart Liyauty

Chart 1 "

Chart Tools Design Tab

Cnm Tools Format tab |

y Eight-Vear Finaneis

Formulas Data Review View

In-ribbon gallery

Items on the ribbon include
buttons and galleries (shown in
Figures 1-8 and 1-9). A gallery is
a collection of choices, arranged in
a grid or list, that you can browse
through before making a selection
of items such as fonts. You can
scroll through choices in a gallery
by clicking its scroll arrows. Or, you
can click a gallery’s More button to
view more gallery options on the
screen at a time.

SU]T": l]l.ltt()n:’i ﬂnd Ilt)xcs
have arrows that, when clicked,
also display a gallery; others always
cause a gallery to be displayed
when clicked. Most galleries
support live preview, an Office
feature that shows the results that
would occur in your file, such as
the cffeets of formatting options

on a document’s appearance, if

you clicked the option you are
pointing to (Figure 1-10). Live
preview works only if you are using
a mouse; if you are using a touch
screen, you will not be able to view
live previews.
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EX 1-10 Excel Module 1 Creating a Worksheet and a Chart

Some commands on the ribbon display
an image to help you remember their function.
When you point to a command on the ribbon,
all or part of the command glows in a darker
shade of gray, and a ScreenTip appears on the
screen. A ScreenTip (Figure 1-11) is a label
that appears when you point to a button or
object, which may include the name, purpose,
or keyboard shorteut for the object. It may also
include a link to associated Help topics, if any.

Some groups on the ribbon have a small
arrow in the lower-right corner, called a Dialog
Box Launcher, that when clicked displays a
dialog box or a pane with more options for the
group (Figure 1-12). When presented with
a dialog box, you make selections and must
close the dialog box before returning to the
document. A pane, in contrast to a dialog box,
is a section of a window, such as the navigation
pane in the File Explorer window, that can
remain open and visible while you work in the
document.

Quitk Access
Toolbar

-—

File

I,EI

Home Insert Draw Page Layout

X Cut
Pasie: 2 Copy {pomeran |
5 F
Clipboard
Paste (Ctrl+V)

Pick a paste option, such as keeping
formatting or pasting only content.

Corbel

painter on
Paste arrow

ainter

I

L

ScreenTip for
Paste arrow

Figure 1-11
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Figure 1-12

Mini Toolbar

The Mini toolbar is a small toolbar that appears automatically next to selected text and that

contains the most frequently used text formatting commands, such as bold, italic, font color, and font size
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Quick Arcess
Toolbar

Fila Home  (nsert Draw Rage Layout Formulas  Daa
.
' Ecepy -

{Figure 1-13). If you do not use the Mini toolbar,
it disappears from the screen. The buttons,
arrows, and boxes on the Mini toolbar may vary,
depending on whether you are using Touch mode
versus Mouse mode. If you right-click an item
in the document window, Exeel displays both f— 5
the Mini toolbar and a shorteut menu, which is
discussed in a later section in this module,

All commands on the Mini toolbar also Augu : Tadt
exist on the ribbon. The purpose of the Mini Sait Yew Fiuléctish S —_
toolbar is to minimize hand or mouse movement. '

Corbel <lam: <A ==

Excel Module 1
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| mini toalbar sl
are an ribbon

Quick Access Toolbar The Quick
Access Toolbar (shown in Figure 1-13) is a
customizable toolbar at the left edge of the title bar that contains buttons you can click to perform frequently

uscd commands. The commands on the Quick Access Toolbar always arc available, regardless of the task you are
performing. If your computer or mobile device has a touch screen, the Touch/Mouse Mode button will appear on
the Quick Access Toalbar and will allow you to switch between Touch mode and Mouse mode. I you are primarily
using touch gestures, Touch mode will add more space between commands on menus and on the ribban so that
they are casier to tap. While touch gestures are convenient ways to interact with Office apps, not all features are
supported when you are using Touch mode. If you are using a mouse, Mouse mode will not add the extra space
between buttons and commands. The Quick Access Toolbar is discussed in more depth later in the module,

Figure 1-13

KeyTips If you prefer using the keyboard instead of the mouse, you can display KeyTips for certain commands
(Figure 1-14). KeyTips are labels that appear over each tab and command on the ribbon when the ALT key is
pressed. To select a command using the keyboard, press the letter or number displayed in the KeyTip, which
may cause addigonal KeyTips related to the selected command to appear. To remove KeyTips from the sereen,
press the avt key or the gsc key until all KeyTips disappear, or click anywhere in the app window.

Formula Bar As vou type, Excel displays your entry in the formula bar, the area above the workshect grid where
you enter or edit data in the active cell (Figure 1-14). You can make the formula bar larger by dragging the bottom
of the formula bar or clicking the expand button to the right of the formula bar. Excel also displays cell information
in the Name box, a box to the left of the formula bar that shows the cell reference or name of the active cell.

Tell Me Box The Tell Me box is a text box to the right of the ribbon tabs that is used to find a command or to
access the Office Help system (Figure 1-14). As you type in the Tell Me box, Excel displays search results that are
refined as you type. For example, if you want to center test in a document, you can type “center” in the Tell Me
box and then select the appropriate command. The Tell Me box also lists related commands and/or the last five
commands accessed from the box.

Microsoft Account Area  In the Microsoft Account area, an area on the right side of the title bar, you can use the
Sign in link to sign in to your Microsoft account (Figure 1-14). Onee signed in, you will see your account information.
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EX 1-12 Excel Module 1 Creating a Worksheet and a Chart

To Display a Different Tab on the Ribbon

The ribbon tab currently displayed is called the active tab. The following step displays the Insert tab; that
is, it makes it the active tab. Why? When working with an Office app, you may need to switch tabs to access other options
for working with a document.

® Click Insert on the ribbon to display the Insert tab (Figure 1-15).

=

B
Y Experiment

» Click the other tabs on the ribbon to view their contents.

» Click the View tab, click the Page Layout tab, and then click the Insert tab again.
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‘ 1. Press ALT, press letter corresponding to tab to display

BTW

Touch Mode
Differences

The Office and Windows
interfaces may vary if you are
using touch mode. For this
reason, you might notice that
the function or appearance
of your touch screen differs
slightly from this madule's
presentation.

Selecting a Cell

To enter data into a cell, you first must select it. The easiest way to select a cell (to
make it active) is to use the mouse to move the block plus sign pointer to the cell and
then click.

An alternative method is to use the arrow keys that are located on a standard
keyboard. An arrow key selects the cell adjacent to the active cell in the direction of the
arrow on the kcy.

You know a cell is selected, or active, when a heavy border surrounds the cell and
the active cell reference appears in the Name box on the left side of the formula bar. Excel
also changes the color of the active cell’s column and row headings to a darker shade.

Entering Text

In Excel, any set of characters containing a letter, hyphen (as in a telephone number),
or space 1s considered text. Text is used for titles, such as column and row titles, on the
worksheet.

Worksheet titles and subtitles should be as brief and meaningful as possible.
A worksheet title could include the name of the organization, department, or a
description of the content of the worksheet. A worksheet subtitle, if included, could
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